
 



ATOMIC ENERGY EDUCATION SOCIETY 

STUDY MATERIAL FOR COMPUTER 

CLASS-IV 

SYLLABUS 

S.No. Unit Contents Page 

Number 

1 Computer History 1.1. Understanding Generations 

1.2. Classification of Computers 

1 

5 

2 Word Processor 2.1 File Menu 

      2.1.1 Create a new file 

      2.1.2 Open an existing file 

      2.1.3 Save the file 

      2.1.4 Save As – saving the file with different 

name (Copy a file) 

     2.1.5 Close the file 

2.2 View Menu 

      2.2.1 Print Layout 

      2.2.2 Web Layout 

      2.2.3 Full Screen 

      2.2.4 Zooming 

      2.2.5 Ruler 

11 

12 

12 

12 

13 

14 

14 

14 

15 

16 

16 

18 

  3 Exploring 

Windows 

3.1 Starting Windows Explorer 

3.2 Components of Explorer Window 

3.3 Panes of the Explorer Window 

3.4 Working with folder in left pane 

3.5 Managing files and folders in Windows Explorer 

3.6 Modes of Views 

3.7 File naming convention 

3.8 Searching Files 

3.9 Creating Shortcuts 

20 

20 

21 

22 

22 

24 

25 

26 

26 

4 Powerpoint 

Presentation 

4.1 Starting Powerpoint 

      4.1.1 Create a new file 

      4.1.2 Open an existing file 

      4.1.3 Save the current file 

      4.1.4 Save As – saving the file with different 

name (Copy a file) 

      4.1.5 Close the file  

4.2 Formatting a Presentation 

      4.2.1 Changing the Font 

      4.2.2 Changing the Font Size, Style, Color. 

      4.2.3 Formatting Paragraphs 

29 

29 

30 

31 

31 

32 

33 

33 

33 

34 

AEES



      4.2.4 Changing Text Alignment 

      4.2.5 Modifying Line Spacing 

      4.2.6 Creating Bulleted and Numbered Lists 

      4.2.7 Copying Formatting 

4.3 Insert Menu / Inserting 

      4.3.1 Images 

      4.3.2 Table 

      4.3.3 Clip Art 

      4.3.4 Screen Shot 

      4.3.5 Shapes and Smart 

      4.3.6 Chart 

      4.3.7 Text Box, WordArt, Date & Time, Slide 

Number, Symbols 

      4.3.8 Moving & Resizing an Image 

4.4 Slide Show Menu 

      4.4.1 from beginning 

      4.4.2 from current slide 

      4.4.3 Custom slide show 

      4.4.4 Setup slide show 

34 

35 

36 

36 

37 

37 

38 

39 

40 

41 

43 

44 

46 

47 

47 

47 

48 

49 

5 Excel Spreadsheet 5.1  Working in Excel 

5.2 Introduction – Wordbook & Worksheet 

5.3 Use in day to day life. 

5.4 Steps to start Excel 

5.5 Components of Excel Screen 

5.6 Various data types 

5.7 Entering data in Spreadsheet 

5.8 About the cell & cell address 

5.9 Auto Sum 

5.10 Formatting the date in the Table 

52 

52 

53 

53 

54 

55 

55 

55 

56 

56 

6 Windows 

Accessories 

6.1 Calculator 

6.2 Onscreen Keyboard 

6.3 Magnifier 

6.4 Games 

6.5 Virus & Anti-Virus 

59 

60 

61 

61 

62 

7 Control Panel 7.1 Display Properties 

7.2 Setting of Mouse 

7.3 Taskbar and Start Menu 

7.4 Date and Time 

64 

65 

69 

69 

 Split-up of Syllabus 

Quarter Period Units 

I  April to June 1,2 and 3 

II July to September 4 

III October to December 5 

IV January to March 6 and 7 

AEES



IV- STD Atomic Energy Education Society 1/71 

UNIT 1 

 COMPUTER HISTORY 

1.1 Understanding Generations 

The computers are classified into 5 generations based on the technology used during the 

period. 

# Generations of computer 

 First-Generation Computer

o Period: 1945 to 1956

o Technology: Vacuum tubes were used.

o Language: Machine language was used for storing and processing data.

o Examples: Some of the first-generation computers are:

 ENIAC (Electronic Numerical Integrator And Calculator)

 EDVAC (Electronic Discrete Variable Automatic Computer)

 Univac-I (Universal Automatic Computer).

o Advantages:

 Fastest calculating devices at that period.

 ENIAC was capable of performing 5000 additions and 350 multiplications

per second.

o Disadvantages

 It was huge in size, so occupied more space.

 They emitted large amounts of heat because they used lots of vacuum

tubes and a Water cooling environment was required to control the heat

generated.

 They were prone to frequent failure hence they were unreliable.

 Not portable. (Cannot carry from one place to another).

 Second-Generation Computer

o Period: 1956-1963

o Technology: Transistors were used.

o Language: Assembly language was used for storing and processing data.

o Examples: Some of second generation computers are:

 IBM 1620 , IBM 1401 and Honeywell 400.

Vacuum tube is a device that  

controls electric 

current between electrodes in 

an evacuated container. 

Transistors are more compact than vacuum 

tubes as they are made up of semiconductors. 
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Advantages: 

 Its size was smaller as compared to the first-generation computers.

o Disadvantages

 Required Air Conditioning environment to control the heat generated.

 Frequent maintenance was required.

 Quite expensive.

 Third -Generation Computer

o Period: 1964-1975

o Technology: Integrated Circuits (ICs) were used. A Single IC has many

transistors, registers and capacitors, placed on a single thin silicon.

o Language: High-Level language such as BASIC, C, COBOL and FORTRAN.

o Examples: Some of third generation computers are:

 IBM- 360, PDP – 8 , PDP- 11 and CRA 1.

o Advantages

 Smaller in size as compared to the second-generation computers.

 Cost is less compared to the second generation computers.

 Generated less heat.

 Reduced computational time. (Increased calculation speed)

 Maintenance cost was less.

 Easily portable.

 Fourth-Generation Computer

o Period: 1976-1989

o Technology: Very Large Scale Integration (VLSI) technology was used.

o Language: Object Oriented Programming language such as C++  and Java.

o Examples: Some of forth generation computers are:

 IBM-PC, Apple Macintosh and Sun SPARC station

o Advantages

 Cost is less compared to the third generation computers

 Huge memory capacity and high functional speed.

 Consumed less power.

 Generated a negligible amount of heat.
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 Fifth-Generation Computer 

o Period: 1990-Till date. 

o Technology: SLSI technology.  

 The fifth generation computers are using Super Large Scale Integrated 

(SLSI) chips that are able to store millions of components on a single 

chip. 

 Language: Prolog, Mercury are the examples of fifth generation 

languages. They are based on Artificial Intelligence (AI).  They try to 

simulate the human way of thinking and reasoning. Artificial 

Intelligence includes areas like Expert System, Natural Language 

Processing. Speech Recognition, Voice Recognition, Robotics, etc. 

o Examples: Some of fifth generation computers are:  

 IBM notebooks, Pentium PCs, SUN Workstations and PARAM 10000 

o Advantages 

 These computers are much faster than other generation computers. 

 Much smaller in size than other generation computers 

 Easily portable and easy to handle. 

 Advancement in Superconductor technology. 

 

 

 

 

Artificial intelligence is Intelligence displayed by machines, in contrast 

with the natural intelligence (NI) displayed by humans and other 

animals. AI research is defined as the study of "intelligent agents": any 

device that perceives its environment and takes actions that maximize its 

chance of success at some goal.  

Super-Large Scale Integration (SLSI) is a 

form of circuit construction with 50,000 to 

100,000 circuit components on 

an integrated circuit. 

Applications of AI include Natural Language Processing, Gaming, Speech Recognition, Vision 

Systems, Health care, Automotive etc. 
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Figure 1. 1: Technologies used in different Generations of Computers 
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1.2 Classification of Computers  

Computers can be classified based on the size, purpose, working principle etc., 

In this chapter we will discuss the classification based on Size and Purpose. 

# Classification of computer based on the size 

 Micro Computer 

 Mini Computer 

 Mainframe Computer 

 Super Computer 

 Micro Computer  

o Micro Computers are the smallest, most affordable and most reliable.  

o Micro Computer is a computer that has a microprocessor chip as its CPU. 

o Microcomputers include (i) portable computers and (ii) Desktop computers. 

(i) Portable Computer 

 Portable (users can carry it) computer is a very small, easy to use 

microcomputer. 

 Portable Computer includes personal digital assistant (PDA), notebook 

computer and laptop. 

(ii) Personal Computer or Desktop Computer 

 The Personal computer is a microprocessor based, single user computer. 

. 

 

 

 

 

 

 

 

 

Figure 1.2: Micro Computer 
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 Mini Computer 

o A Minicomputer is a medium sized computer developed in 1960s.  

o  An early and highly successful minicomputer was Digital Equipment 

Corporation's (DEC) 12-bit PDP-8. 

 

 

 

 

 

 

Figure 1.3 : PDP-8 

 Mainframe Computer  

o A mainframe computer is a large, powerful computer that handles the 

processing for many users simultaneously (up to several hundred users). 

o The mainframe computers have large storage capacities, very high speed of 

processing (compared to micro and mini computers). 

o They are kept in air-conditioned environment.  

o Applications: They are used by big companies, banks, government 

departments, etc.   

 

 

 

 

 

Figure 1.4: Mainframe Computer 
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  Supercomputer  

o It is the largest computer. 

o A supercomputer is the fastest and the most expensive computer.  

o This has extremely large storage capacities and computing speeds that are at least 

ten times faster than that of other computers. 

o  It can perform hundreds of millions of instructions per second.  

o Applications: The super computer is used for specialised applications such as 

large-scale numerical problems in scientific and engineering disciplines. These 

include applications in electronics, petroleum engineering, weather forecasting, 

medicine and nuclear energy research.  

 

 

 

 

 

 

Figure 1.5: Supercomputer 

# Classification of computer based on usage 

  Special purpose computer 

 General purpose computer 

 Special Purpose Computer  

o Special purpose computers are designed for the requirements of a particular task or 

application. 

o Application Specific Integrated Circuit, Pronounced "a-sick." A chip that is custom 

designed for a specific application rather than a general-purpose chip such as a 

microprocessor. 

o For example,computers used for weather forecasting. It incorporates the instructions 

to perform the specific application  into the design of internal storage. 
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Figure 1.6 : Special Purpose Computer 

 General Purpose Computer  

o The general-purpose computer is designed to meet the needs of many different 

applications.  

o The instructions needed to perform a particular task are not wired permanently 

into the internal memory. When one job is over, instructions for another job 

can be loaded into the internal memory for processing.  

o Thus, a general-purpose computers can be used to prepare paybills, manage 

inventories, print sales reports, do scientific calculations and so on.  

 

 

 

 

Figure 1.7: General Purpose Computer 

 

 

 

EXERCISES 
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I. Match the following Computer Generations given in the column-I against 

the technology used during that generation given in the second column and 

write the respective alphabets in the below given line. 

 

 

 

 

 

 

 

 

 

Answers: 1.____ 2. ____ 3. ____ 4. ____ 5. ____ 

II. True or False 

1. 1
st
 generation computers emited large amounts of heat. 

2. Object Oriented Langages were used in 4
th

  generation computers. 

3. Prolog, Mercury are the examples of 1
st
 generation language. 

4. A mainframe computer has large storage capacities. 

5. Portable computers cannot be moved from one place to another. 

 

 

 

 

Column-I 

Computer 

Generation 

Column-II 
Technology Used 

1. 1
st
 Generation A. Very Large Scale Integration 

2. 2
nd

 Generation B. Vacuum Tube 

3. 3
rd

 Generation C. Super Large Scale Inegration 

4. 4
th
 Generation D. Transistors 

5. 5
th
 Generation E. Integrated Circuits 
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III. Solve the crossword puzzle. (Clue: Use, the terms of “Types of 

computers”). 
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UNIT II  

WORD PROCESSOR 

2.1 File Menu 

In MS Office 2007, the basic commands of File Menu such as New, Open, Save as, Close 

are available in Office button. 

2.1.1 Create a new file 

 Steps to Create a new file 

o Click on Office button. 

o Click on New option. 

o The New Dialog box will appear as shown below. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

Figure 2.1 : New document dialog box 

 

o Select Blank Document option. 

o Click on Create button.  

o A new document will be displayed. 
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2.1.2 Open an Existing file 

 Steps for Opening an Existing file 

o Click on Office button.  

o Click on Open option. 

o An Open Dialog box will appear as shown below, 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.2 : Open dialog box 

o Select the location of the file to be opened . 

o Open the file by double clicking on it  

o Click Open button. 

2.1.3 Save the current file 

Whenever a new file is created, it must be saved in the specific location, so that the user can 

access the file for further use. 

  Steps to save the Document for the first time 

o Click the Office button.  

o Click on Save option.  

o Save as dialog box appears as shown below, type the file name.  
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Figure 2.3 : Save as dialog box 

o Click on Save button 

The word file is saved with the .docx extension  

Word saves the document in a default location. To save the document in a particular location, 

select the appropriate folder name as shown in the figure. 

2.1.4 Save As- saving the file with different name (Copy file) 

 “Save” and “Save As” both are used for different purpose.  

 “Save” option is used when the file is to be saved for the first time.  

 Save as option is used when a already saved file needs to be saved with another name 

(like making another copy), in this case the previously saved copy also available. 

  Steps to save the file with different name (Save As) 

o Open the file, which is to be saved in another name. 

o Click on the Office button 

o Click on Save As option shown in the menu  

o The Save As dialog box appears as shown below, 
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Figure 2.4 : Save as dialog box 

o Select the location of the file. 

o Type the new file name  

o Click on save button. 

2.1.5 Close the file 

Before closing the file, save the file as mentioned in 2.1.3 

 Steps to Close the file 

o Click on the Office button. 

o Click on the Close option.  

Or 

o Click on the Close button on the windows control. 

2.2 View Menu 

2.2.1 Print Layout 

Print layout is used to view the document as it will appear on the printed page. 

 Steps to View the file in Print Layout view 

o Click on View Menu 

o Click on Print Layout icon in the Document views group. 

o The document appears as it will appear on the printed page. 
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Figure 2.5 : Print layout view- A sample screen shot 

2.2.2 Web Layout 

Web layout is used to view the document as it would look as a webpage.  This layout can be 

used for designing documents for the web. So the view enables you to get an idea of how the 

document would look as a webpage. 

 Steps to View the file in Web Layout view 

o Click on View Menu 

o Click on Web layout icon in the Documents view group.  

o The document appears as it will appear on the web page. 

  

 

 

 

 

 

Figure 2.6 : Web layout view- A sample screen shot 
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2.2.3 Full Screen 

Full screen layout is used to view the document in full screen reading view in order to 

maximize the space available for reading or commenting on the document. 

 Steps to View the file in full screen view 

o Click on View Menu 

o Click on Full Screen Reading  icon in the Documents view group.  

o The document appears in the full screen reading view as shown in the screen shot 

given below, 

 

 

 

 

 

 

 

 

 

 

Figure 2.7 : Full Screen view- A sample screen shot 

2.2.4 Zooming 

Zoom is used to get a closure view of the document. 

Zoom controls are also available on the status bar at the bottom of the window. 

 Steps to View the file in full screen view 

o Click on View Menu 

o Click on the Zoom icon in the Zoom group. 

o The zoom dialog box appears as shown below, 
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 Figure 2.8 : Zoom dialog box 

o Select the value of percentage to be zoomed. 

o Click on Ok button. 

o The document is zoomed as shown below, 

 

 

 

 

 

 

 

 

 

Figure 2.9 : Zooming view- A sample screen shot 
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2.2.5 Ruler 

The ruler is used to measure and line-up objects in the document. 

 Steps to use Ruler 

o Click on View Menu 

o Click on the ruler icon in the Show/Hide group. 

o The document appears with a ruler as shown below, 

 

 

 

 

 

 

 

 

Figure 2. 10: Ruler screenshot 
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EXERCISES 

I. State True of False. 

1) For a newly created document both "Save" and "Save As" options work as 

same for first time. 

2) We can not insert tables inside a word document. 

3) We can also use Escape (Esc) key present on the key-board to come from full 

view mode to normal view mode. 

4) With the help of ruler we can re-size the margin size. 

5) To quickly edit we use Draft view. 

II. PRACTICAL EXERCISES   

1. i. Create a word file  

   ii. Type your name, class, section, roll no. and your ambition one by one. 

   iii. Save the file with the name “AboutMe” 

   iv. Close the file 

2. i.  Open the file named “AboutMe”  

   ii. Write your hobbies at the last line of  the file. 

  iii. Save the file with the name “MyHobbies” 

3. i. Open the file “AboutMe”  

ii. View the file using Print Layout view, Web layout view, Full screen and 

Zooming. 
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UNIT- III 

EXPLORING WINDOWS 

3.1 Staring Windows Explorer 

Windows Explorer is the file management application in Windows. Whenever the user 

accesses a disk or opens a folder containing files, they are using the Windows Explorer 

utility. 

When a file is selected within the Windows Explorer interface, users can perform various 

actions such as renaming, moving, copying, emailing, printing or deleting the file. Entire 

folder can also be opened, explored, shared, copied, cut, pasted, moved or deleted. 

 Steps to start windows explorer 

o Right-click on the Start button  

o Click on Open Windows Explorer option. The explorer window appears as 

shown in figure 3.1 

                                                            Or 

o Press Windows+E on the keyboard (shortcut for opening windows explorer). 

3.2 Components of Explorer Window 

The windows explorer has several components as shown below, 

 

 

 

 

 

 

Figure 3.1: Components of Windows explorer 
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 Back/Forward button: It is used to go back to previous location and again come 

back to the same location respectively. 

 Address Bar: It shows the current location of the file or folder selected. Use the 

Address bar to navigate to a different folder without closing the current folder 

window. 

 Tool Bar: It consists of the tools for organizing the folder contents, for showing the 

system properties, to uninstall or change a program, to open control panel etc., 

 Windows control: It consists of three buttons for Minimizing, Maximizing and 

Closing the windows explorer. 

 Search box: It is used to look for a file in the current folder by entering a word in the 

search box. As soon as a single character is entered, it starts searching the files. 

 Content Area: It contains the folders and when the folder is open it shows the files in 

the folder. 

3.3 Panes of Explorer Window 

 

 

 

 

 

 

 

Figure 3.2: Components of Windows explorer 
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 Navigation pane or left pane: The Navigation Pane appears on the left side of 

the windows explorer. By default, the navigation pane displays five sections: 

Favorites, Libraries, Homegroup, Computer and Network. 

 Details pane: It shows the common properties of the selected files, such as file name, 

authors, size, date modified, pages etc., 

 Preview pane: It shows the content of the file without opening it in a program. 

3.4 Working with folder in left pane 

 Using the Navigation pane or left pane, you can navigate directly to the folder that 

contains the files you are looking for. 

 Navigation pane or Left pane is used to directly navigate to the required file. 

 

 

 

 

 

 

 

 

 Figure 3.3: Left Pane 

3.5 Managing files and folders in Windows Explorer 

# Create a new folder 

 Steps for creating a new folder 

o Open the Windows Explorer by pressing Windows key+E on the 

keyboard. 

                   Windows key 
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o Open the drive (Say for D: or E:) in which new folder needs to be created.  

o Right click on the content area of the Windows Explorer window. 

o Click on New option. 

o Click on Folder option as shown below, 

 

 

 

 

 

 

 

Figure 3.4 : Creating a new folder – screen shot 

o A folder named New folder is created. 

o When the folder is created for the first time, the name “New folder” is 

highlighted, if the user wish to rename the folder, type the required folder 

name.   

# Delete a folder or file 

 Steps for deleting a folder 

o Open the Windows Explorer by pressing Windows key+E on the 

keyboard. 

o Open the drive in which the folder or file to be deleted is saved.(Say for D: 

or E:) 

o Select the folder to be deleted. 

o Right click on the folder 

o Click on Delete option. 

o A dialog box appears asking that “ Are you sure you want to move this 

folder to the Recycle Bin?” as shown below, 
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Figure 3.6: Delete folder – dialog box 

o Click on Yes. The folder and its contents will be moved to Recycle Bin. 

3.6 Modes of View 

The files and folders displayed in the content area of the windows explorer can be viewed 

in one of the following modes.  

 Different modes of file views are, 

o Extra Large Icons 

o Large Icons 

o Medium Icons 

o Small Icons 

o List 

o Details 

o Tiles 

o Contents.  

 

 

 

 

 

 

 

 

Figure 3.6 : Different  Modes of Views 
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In the following table the screenshot of different file views is shown, 

 

Extra large icon View 

 

 

 

 

Large icon View Medium large icon VIew 

 

Small icon View 

 

 

 

 

List View 

 

Details  View 

 

Tiles View 

 

 

Content View 

 
 

 

 

 

 

Figure 3.7:Screen shots of different modes of file views 

3.7 File naming convention 

 Standards for naming the file is called file naming convention. 

o Use a period (dot) to separate the base file name from the extension in 

the name of the file. 

o Use the underscore ( _ ) as element delimiter. 

o Do not use spaces or other characters such as: ! # $ % & ' @ ^ ` ~ + , . ; 

= ) ( 

o Do not assume case sensitivity. For example, IV STD, IV std and IV 

Std are same. 
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3.8 Searching Files 

 A file can be searched from a folder, disk or computer by entering a word in the 

search box shown in figure 3.1 of the windows explorer.  

 If the user does not remember the file name, by using the file extension also the files 

can be searched. 

 For example, if the user is searching for a word document typing “*.docx” in the 

search box, displays all the word documents. 

 

3.9 Creating Shortcuts 

 A shortcut is useful for accessing a file or software program easily without looking 

through the Start Menu. 

    For example, a file is saved in D: drive, IV std folder, with file name sample1.docx 

and the shortcut for the file (sample1.docx – Shortcut) is created and placed on the 

desktop, whenever want to open sample1.docx file click on the “sample1.docx – 

Shortcut” on the desktop. 

 Steps to create shortcut 

o Open the location of the file or software program for which shortcut needs to 

be created. 

o Select the file or software program and right click on it 

o Click on Create shortcut option. 

o A shortcut file is created in the same location with a small arrow in the bottom 

left corner of the icon. 

o Once the shortcut is created, it can be copied or cut and passed on the desktop 

for easy access. 

 

 

 

 

 

In Windows shortcut file extension is .lnk. 
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Figure 3.8: Creating shortcut 
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EXERCISES 

I. Write True or False. 

1) List view shows the size of file. 

2) When we delete a file or folder, it is moved to MyDocuments. 

3) Confirmation Dialog box appears before deleting a file or folder. 

4) We can use @ symbol in the file name even though it is not a file name 

convention. 

5) we can give the file name with any length. 

PRACTICAL EXERCISES    

1. i. Open windows Explorer using shortcut. 

   ii. Create a folder in D drive with your name. 

   iii. Move the files “AboutMe” and “MyHobbies” to this folder. 

 iv. View the files in this folder in different file views(Extra Lagre Icons, 

Large Icons, Medium Icons, etc.,) 

   v.  Create shourtcuts for both the files. And place it on the desktop. 

2. Search the “MyHobbies” file using the search box. Open the file. 
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UNIT- IV 

POWERPOINT PRESENTATION 

4.1 Starting Powerpoint 

Powerpoint is an application software used to create presentations. 

4.1.1 Create a new file 

 Steps to create a new file 

o Click on Start button 

o Click on All Programs 

o Click on Microsoft Office 

o Click on Microsoft Office PowerPoint 2007 

o The New Presentation dialog box will appear as shown below, 

  

 

 

 

 

 

 

 

 

Figure 4.1: New Presentation dialog box 

o Blank and recent Template was selected by default. 

o Click on Blank presentation will be created. 
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Figure 4.2: A Blank Presentation 

4.1.2 Opening an Existing file 

 Steps for Opening an Exiting file 

o Click on Office button  

o Select Open. 

o An Open Dialog box will appear as shown below, 

 

 

 

 

 

 

Figure 4.3: Open dialog box 

o Select the file location and click on it. 

o Click on Open button. The selected file opens. 
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4.1.3 Save the current file 

  Steps to save the current file for the first time 

o Click the save option as shown here,               on the Quick Access Toolbar. 

o Save as dialog box appears as shown below, type the file name.  

 

 

 

 

 

 

 

Figure 4.4 : Save as dialog box 

o Click on Save button 

The power point presentation is saved with the .pptx extension  

4.1.4 Save As- saving the file with different name (Copy file) 

 “Save” and “Save As” both are used for different purpose. 

  “Save” option is used when the file is to be saved for the first time.  

 “Save as” option is used when a already saved file needs to be saved with another 

name (like making another copy), in this case the previously saved copy also 

available. 

  Steps to save the file with different name (Save As) 

o Open the file, which is to be saved in another name. 

o Click on the Office button 

o Click on Save As option shown in the menu  

o The Save As dialog box appears as shown below, 
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Figure 4.5 : Save as dialog box 

o Select the new location of the file. 

o Type the new file name. 

o Click on save button. 

4.1.5 Close the file 

Before closing the file, save the file as mentioned in 4.1.3 

 Steps to Close the file 

o Click on the Office button. 

o Click on the Close option.  

                                                   or 

o Click on the Close button on the windows control. 
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4.2 Formatting a Presentation 

Formatting means organizing the text and  images in the presentation. Formatting includes 

changing the font size, style, color,  line spacing and text alignment etc. 

4.2.1 Changing the font 

 Steps to change the font 

o Select the text for which the font style has to be changed. 

o Right click and click on font option 

o The font dialog box appears as shown in the figure 

  

 

 

 

 

 

 

 

Figure 4.6 : Font dialog box 

4.2.2 Changing the Font size, Style, Color 

 Steps to change the font size, style, color 

o Select the text for which the font size, style and color has to be changed. 

o Right click and click on font option. 

o The font dialog box appears as shown in the figure. 

o Select the font style, size and color. 

o Click on OK button. 
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Figure 4.7: Changing font Size, Style, Color 

4.2.3 Formatting Paragraphs 

# Steps to format Paragraphs 

 Select the text to be aligned 

 In the Paragraph group of the Home tab, click on any one of the option from left, 

center, right or justify. 

 

 

Figure 4.8: Paragraph group on Home tab 

2.2.4 Change Text Alignment 

Text can also be vertically aligned within a text using the Align text button. 
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# Steps to Change text alignment 

 Select the text to be aligned. 

 In the Paragraph group of the Home tab, click on the Align Text button. 

 Click on any one of the options from left, Top, Middle or Bottom. 

 

 

 

 

 

 

Figure 4.9 : Options in Align text button 

4.2.5 Modifying Line spacing 

# Steps to change the line spacing 

 Select the text for which line spacing needs to be changed. 

 Click the Line Spacing button in the Paragraph group of the Home tab. The following 

options will appear,  

 

 

 

 

Figure 4.10: Line spacing options list 

 Click the required line spacing from the list shown in figure 4.10 
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2.6 Creating Bulleted and Numbered List 

# Steps to create bulleted list 

 If the list is already available, Select the 

list of items for which the bullets needs to 

be inserted. 

 Click on the Bullets button in the 

Paragraph group on the Home Tab. 

 The options available under the Bullets button appear as shown below, 

 

 

 

 

 

 

 

 

 

 

Figure 4.12 : Different types of bullets available. 

 

 Click on the Symbol, the symbol will be applied to all the items in the list. 

 For adding more items in the list, keep the cursor at the end of the last item and press 

Enter button. 

 

4.2.7 Copying Formatting 

As we copy and paste the text (content) , it is also possible to copy the format of a text such 

as font size, style and color of the text and apply it to another text. 

 

Figure 4.11 : Bullets Button  
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# Steps to copy formatting 

 Select the text from where the format has to be copied. 

 Click on the Format Painter Button in the 

Clipboard group on the Home Tab. 

 Along with the cursor a brush symbol will be 

inserted. 

 Place the cursor on the text for which the copied 

format needs to be applied. 

Figure 4.13: Format Painter 

4.3. Insert Menu/ Inserting 

We can insert images, tables, ClipArt, Screen Shot, Shapes and SmartArt, Chart, Text box, 

Date & Time, Slide Number and Symbols etc. in the presentation. 

4.3.1. Images 

# Steps to insert an Image 

 Click on the Insert menu 

 Click on the Picture button on the Illustration group. 

 

Figure 4.14: Picture button 
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 The following Insert Picture dialog box appears, 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.15: Insert picture dialog box 

 Select the location of the picture to be inserted.  

 Select the image to be inserted.  

 Click on Insert button. 

4.3.2. Table 

# Steps to insert an Image 

 Click on the Insert menu 

 Click on the Table button on the Tables group. 

Figure 4.16: Tables button 
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 The following Insert Table options appears, 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.17: Insert Table 

 Select the number of rows and columns to be inserted in the Table 

 Press Enter. The table is inserted on the presentation. 

4.3.3. Clip Art 

# Steps to insert ClipArt 

 Click on the Insert menu 

 Click on the ClipArt button on the Illustration group. 

 

Figure 4.18: ClipArt button 
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 The following ClipArt dialog box appears, 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Click on the ClipArt which needs to be inserted. 

4.3.4 Screen Shot 

A screen shot, records what's on the computer screen at that moment in time.  

The snapshot can be copied to the clipboard and use it as an image in most Windows 

programs, including Microsoft PowerPoint 2007.  

# Steps to Take a Full-Screen Snapshot and use it on the Powerpoint 

 To take a snapshot of the entire screen press on the "Print Screen," "PrtScn" or 

"PrtSc" button on the keyboard.  

 Everything visible on the screen, including the Windows 7 task bar, is captured. 

 Open or create a presentation. 

 Select the slide in which the snapshot needs to be imported. 

 Press "Ctrl-V" to paste the snapshot from the clipboard into the PowerPoint slide. 

 Click and drag the small circles and squares that delimit the snapshot to resize it. 

Click and drag the entire snapshot to reposition it on the slide. 

Figure 4.19: ClipArt dialog box 
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4.3.5 Shapes and SmartArt 

# Steps to insert Shapes 

 Click on the Insert menu 

 Click on the Shapes button in the Illustration group 

 

 

 

 

 

  

 

Figure 4.20: Shape button 

 

 The Recently Used Shapes appear as shown below, 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.21: Recently Used Shapes 

 Click on the required shape 

 Keep the cursor on the slide where the shape needs to be inserted. 

 Click the mouse and drag it. The shape will be drawn. 
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# Steps to insert SmartArt 

 Click on the Insert menu 

 Click on the SmartArt button in the Illustration group 

 

 

 

 

 

 

Figure: 4.22: SmartArt 

 

 Choose a SmartArt Graphics appear as shown below, 

 

 

 

 

 

 

 

 

 

 

Figure 4.23: Choose a SmartArt Graphics  

 Double Click on the required SmartArt 

 The chosen SmartArt will be inserted in the Powerpoint presentation. 

 Add the text in the SmartArt. 
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4.3.6 Charts 

# Steps to insert Chart 

 Click on the Insert menu 

 Click on the Chart button in the Illustration group 

 

 

 

 

 

 

 

Figure 4.24: Chart button 

 Choose a Chart window appears as shown below, 

 

 

 

 

 

 

 

 

Figure 4.25: Insert Chart Window 

 Double Click on the required Chart type 

 The chosen Chart will be inserted into the powerpoint presentation. 
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4.3.7 Text Box, WordArt, Date & Time, Slide Number, Symbols. 

# Steps to insert WordArt 

 Click on the Insert menu 

 Click on the TextBox button in the Text group 

 

 

 

 

 

Figure 4.26: Text box button 

 Keep the cursor on the slide, a textbox will appear where text can be entered. 

# Steps to insert WordArt 

 Click on the Insert menu 

 Click on the WordArt button in the Text group 

 

 

 

Figure 4.27: WordArt button 

 Different patterns of WordArt appear as shown below, 

 

 

 

 

Figure 4.28: Different patterns of WordArt 
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 Double Click on the required pattern 

 The chosen WordArt will be inserted  

# Steps to insert Date & Time, Slide number 

 Click on the Insert menu 

 Click on the Date and Time button in the Text group 

 

 

 

 

 

Figure 4.29 : Date and Time button 

 Header and Footer appear as shown below, 

 

 

 

 

 

 

Figure 4.30: Header and Footer Window 

 Click on the Date and Time check box for including the date and time on the slide. 

 Click on the Slide number check box for inserting the slide number on the slides. 

# Steps to insert Symbols 

 Click on the Insert menu 

 Click on the Symbols button in the Text group 
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Figure 4.31: Symbols button 

 The Symbols dialog box appears as shown below, 

 

 

 

 

 

 

Figure 4.32: Symbols dialog box 

 Click on the required Symbol 

 Click on the Insert button. 

 Click on Close button. 

4.3.8 Moving & Resizing an Image 

# Steps for Moving an Image 

 Select the image. 

 The arrow move icon appears on the image 

 Click the mouse, drag and drop the image.  

# Steps for Resizing an Image   

 In the Size group of Picture Tools tab, mention the required Height and Width. 
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Figure 4.33: Height and Width 

Or 

Click and drag a corner handle of the image  

 Select the image to  resize smaller or larger. 

 4.4. Slide Show.Menu 

 4.4.1 from Beginning 

 # Steps to view the slide show from the beginning 

 Open the power point presentation which needs to be viewed in the Slide 

Show. 

 Click on the View menu. 

 Click on Slide Show button in the Presentation Views Group. 

 

Figure 4.34 : Slide Show button 

 The Slide show will be displayed from the first Slide onwards. 

4.4.2 from current slide 

# Steps to view the slide show from the current slide 

 Open the power point presentation which needs to be viewed in the Slide 

Show. 
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 Click on the slide from where the presentation has to begin. 

 Press Shift + F5. 

 The Slide show will begin from the slide which was selected. 

4.4.3 Custom Slide show 

 Use a basic custom show to give separate presentations to different groups. 

 For example, if your presentation contains a total of five slides, you can 

create a custom show named "Site 1" that includes just slides 1, 3, and 5.  

# Steps to view Custom slide show 

 Click on Slide Show Menu 

 Click on Custom Slide Show in the Start Slide Show 

 Click on Custom Shows option. 

 Custom Shows dialog box appears as shown below, 

 

 

 

 

Figure : 4. 35: Custom Shows Window 

 Click on New button 

 Define Custom Show dialog box appears as shown below, 

 

Figure 4.36: Define Custom Show Window 
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 Under Slides in presentation, click the slides that you want to include in 

the custom show 

 Click Add.  

 

 

 

 To change the order in which slides appear, under Slides in custom show, 

click a slide, and then click one of the arrows to move the slide up or down 

in the list. 

 Type a name in the Slide show name box, and then click OK. To create 

additional custom shows with any slides in your presentation, repeat steps 

1 through 5. 

4.4.4 Setup slide show 

# Steps to Setup slide show 

To set up a PowerPoint presentation to run automatically, do the following: 

 On the Slide Show tab, click Set Up Slide Show. 

 

 

 

 

 

 

Figure 4.37: Set up Slide Show button 

 

Note:  To select multiple sequential slides, click the first slide, and then hold 

down SHIFT while you click the last slide that you want to select. To select 

multiple non sequential slides, hold down CTRL while you click each slide that 

you want to select. 
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 Click on Presentation by a speaker, under Show type. 

 

 

 

 

 

 

 

Figure 4. 38: Set up Show dialog box 
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EXERCISES   

I. State True of False    

    1. In Power point we can add animations (Motion to the pictures). 

    2. There is a limit to the number of slides present in the Power point. 

    3. We use bullet list instead of Numbered list when there is no priority among 

the list items. 

4. We can use Escape (Esc) button on the key-board to stop the slide show 

presentation. 

    5. We can not insert a table in a slide. 

PRACTICAL EXERCISES   

   1. i. Create a power point presentation on the topic “Flowers” with minimum 

5 slides. 

          (Hint: Write about flowers. Insert some images of the flowers.)  

         ii. List out the names of some flowers using bullets. 

         iii. Save the file with the name “Flowers”. 

   2.  Create a power point presentation on the topic “Computer” using ClipArts . 

   3.  Create a power point presentation on the topic “Shapes” with minimum 5 

slides, include one shape per slide and name the shape using SmartArt.  

4.  i. Open the presentation named “Flowers”, insert date, time and slide  

number. 

        ii. Save it with the name “Flowers for print”. 

        iii. View the presentation in the Slide show. 
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UNIT- V 

EXCEL SPREADSHEET 

5.1 Working in Excel 

Excel is an application software to create tables and perform calculations. 

5.2 Introduction- Workbook & Worksheet 

# Workbook  

 The Workbook is a collection of worksheets.  

 When a new excel file is created, a new workbook opens. 

 By default the workbook consists of three worksheets. 

 More Worksheets can be added to the workbook. 

 A worksheet can also be deleted from the workbook. 

 A worksheet is used to organize various kinds of related information. 

 

 

 

 

 

 

 

 

 

Figure 5.1: A workbook 

# Worksheet 

 A worksheet is a collection of cells, where data is entered and can be manipulated. 

 A cell is an intersection of a row and a column. 

 Rows are named with Arabic numbers. 
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 Columns are named with Alphabets. 

 A cell is named as a combination of intersecting column name and row name 

respectively. Example: A1 

 

 

 

 

 

 

 

  

Figure 5.2: A worksheet 

 An active cell is a cell which is currently selected. It will be highlighted by a 

rectangular box and its name will be shown in the name box. In the figure 5.2 A1 is 

the active cell. 

5.3 Use in day to day life.   

Excel  is used to perform  

 Calculations 

 Analysis  

 Visualization by creating charts and graphs of data and information.  

5.4 Steps to start Excel  

# Steps to start Excel are  

 Click on Start button 

 Click on All Programs 

 Click on Microsoft Office 

 Click on Microsoft Office Excel 2007  

 An Excel workbook will be displayed as shown in the figure 5.1 
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5.5 Components of Excel Screen 

 

 

 

 

 

 

 

 

 

 

Figure 5.3: Components of Excel Screen 

 Office Button: It provides the option to open a new worksheet, existing worksheet, 

saving the worksheet, save the worksheet in a different name, print and etc., 

 Name box: It displays the name of the active cell. A cell is named as a combination 

of intersecting column name and row name respectively. Example: A1 

 Quick Access Toolbar: A toolbar to quickly access the options which you frequently 

use. You can add your favorite options by adding new options to the quick access 

toolbar. 

 Formula Bar: Formula bar is an input bar, below the ribbon. It shows the content of 

the active cell and you can also use it enter a formula in a cell. 

 Row: A row is a horizontal set of cells. A single worksheet contains 1048576 total 

rows. Every row has its own number for identity, starting from 1 to 1048576. You can 

select a row clicking on the row number marked on the left side of the window. 

 Title Bar: The title bar will show the name of your workbook, followed by the 

application name (“Microsoft Excel”). 
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 File Menu: The file menu is a simple menu as like all other applications. It contains 

options like (Save, Save As, Open, New, Print, Excel Options, Share, etc.). 

  Ribbon Tab:  Ribbon tabs are the bunch of specific option group which further 

contains option.   

 Sheet Tab: This tab shows all the worksheets which are present in the workbook. By 

default, three worksheets are there in a new workbook with a name of Sheet1, Sheet2, 

Sheet3 respectively. 

 Status Bar: It is a thin bar at the bottom of the Excel window. It will give you an 

instant help once you start your working in Excel. 

5.6 Various data types 

Microsoft Excel is able to identify the type of data you key into the worksheet. You 

can enter various kinds of data in a cell. 

 Text: Text is an alphabetical representation that could includes descriptions, sentence, 

and headings.  

 Number: This type of data consists of numbers, which could be used to represent 

integers, prices, percentage and other numeric information. Most tables are consist of 

numbers, and chart could only be plotted by numbers. Some of the numbers could 

includes comma, decimal points and maybe represented by currency symbol. 

 Dates and Times: This datatype is to be used while entering the date and time. 

5.7 Entering Data in Spreadsheet 

 Select the cell and type the new data.  

 Click the formula bar, make the edits and Press enter. 

 Double click the cell to place the insertion point in it, make the desired edits and press 

enter. 

5.8 About the cell and cell address 

 A Cell: A cell is an intersection of a row and a column. Rows are named with Arabic 

numbers. Columns are named with Alphabets.  

 Cell Address: A cell is named as a combination of intersecting column name and row 

name respectively. Example: A1 
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5.9 Auto Sum 

AutoSum is a function used to enter the appropriate formula automatically. For example, if 

you wanted to add the values of cells A1 through A5, highlight cells A1 through A5 and click 

the AutoSum button, as shown in the picture to the right. Clicking this button after 

highlighting the cells creates the formula =SUM(A1:A5) in cell A6 (first cell after last 

highlighted cell) and gives you the total of all those cells. 

# Steps to calculate AutoSum 

 Select the cells, which contain the values to be added. 

 Click on the AutoSum icon available in the Editing Groups. 

 Click on the Sum option. 

 Automatically the formula for adding the selected range of cells will be inserted in the 

next cell and the total will be displayed.  

 

 

  Figure 5.4: AutoSum icon 

5.10 Formatting the Data in the table 

 Select the cells which contains the data to be formatted . 

 Right click on the selected cells. 

 Click on format cells. 

 Format Cells dialog box appears as shown below, 
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Figure 5.5: Format cells dialog box 

Text alignment of the data can be formatted using alignment tab, font style, size of the 

data can be formatted using of the Font tab in the dialog box. 
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EXERCISES 

I. Fill in the blanks with the correct answer by using the words given below 

in the box. 

 

 

1. The __________________ is a collection of worksheets. 

2. The workbook consists of __________________ by default. 

3. ____________________ show the name of the worksheet. 

4. Text, Number, Dates and Times are some________________of Excel. 

5. A ___________ is an intersection of a row and a column.  

II. State True or False. 

1. In Excel-2007 we can put different colours in the same cell . 

2. By using MS-Excel we can draw paintings. 

3. Basic file operations (Creating, Deleting, Renaming, Editing) are 

mostly same for both MS-Word and MS-Excel. 

4. With the help of View-> Gridlines option we can make the sheet as 

blank paper. 

5. When we open a new Excel sheet cell A1 is in actived (selected) state. 

III. Answer the following.  

 1. Write the components of Excel screen. 

2. Write the use of excel in day to day life. 

3. Define - Cell Address 

4. Write the purpose of AutoSum function. 

5. Define - Active Cell. 

 

Title bar, Workbook, 3 Workbooks, Cell, Datatypes 
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UNIT- VI 

WINDOWS ACCESSORIES 

Accessories are a set of standard applications in Windows.  

Windows accessories are Calculator, Paint, Notepad, Word Pad etc.  

 

 

6.1 Calculator  

The calculator looks like a pocket calculator. It has number keys, memory keys and standard 

math operations. The Calculator can be operated with the help of keyboard or mouse. 

 

 

 

 

 

 

 

 

 

 

Figure 6.1: Calculator 

There are three menus in the calculator 

1. View menu 

2. Edit Menu 

3. Help menu 

 

The Calculator can be opened also by typing calculator or calc in the search box  
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 View menu 

o It allows you to use different programming capabilities like scientific, 

programmer and statistical calculator. 

o The view menu provides other useful features such as Date calculation, Unit 

conversion.  

o The Date calculation option is used to calculate the difference between two 

dates in terms of years, months, weeks and even days.  

o The Unit conversion option is used to convert values from one unit of 

measurement to the other. 

 Edit menu: It allows the user to copy values from the calculator and paste it in 

another location and vice versa.  

 Help menu: Help menu guides the user about how to use the calculator. 

 6.2 On-screen Keyboard 

 On-screen Keyboard can be used instead of the physical keyboard to type and enter 

data. 

 On-Screen Keyboard displays a visual keyboard with all the standard keys.  

 Keys can be selected using the mouse or another pointing device. 

# Steps to include Onscreen Keyboard 

 Click on the Start button. 

 Click on All Programs. 

 Click on Accessories. 

 Click on Ease of Access. 

 Clicking On-Screen Keyboard. 

 

 

 

 

  Figure 6.2: Onscreen keyboard 
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# Steps to use a Numeric Keypad in the On-screen Key 

 Click Options 

 Select the Turn on the numeric key pad check box 

 Click OK. 

 6.3 Magnifier 

 Magnifier can be used to magnify all or part of the screen and has three different 

modes of operation: 

o Full-screen mode—In full-screen mode, the entire screen is magnified.  

o Lens mode—In lens mode, a separate window around the mouse pointer is 

created that acts like a magnifying glass. When you move the mouse pointer, 

this window moves along with it. 

o Docked mode— In docked mode, the magnified area is docked to the top of 

the screen. This is the only mode available if Aero is disabled. 

6.4. Games   

# Steps to include Games 

 Click on the Start Button   

 Click All Programs. 

 Click the Games folder. 

 Click the game you want to run. 

# Some of the games are, 

 Minesweeper 

 Spider Solitaire  

 Purple Place  

 Mahjong Titans 

Windows 7 also includes Chess Titans, Hearts, Internet Backgammon, Internet Checkers, 

Internet Spades, Mahjong Titans, Purple Place and Spider Solitaire. 
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# Minesweeper 

 

 

 

 

 

 

 

 

 

Figure 6.n: Minesweeper 

Windows Minesweeper is a software game that has been included with all versions of 

Microsoft Windows up through Windows 7. 

 

6.5 Virus & Anti-Virus  

# Virus: A computer virus is a type of malicious software program that, when executed, 

replicates itself modifying other computer programs and inserting its own code. 

# Anti-Virus: It is an application program which is designed to detect and remove Viruses 

from the Computer System. 

The Windows 7 operating system from Microsoft simplifies computer security, making it 

easier for you to reduce the risk of damage caused by viruses, spyware and other malware.  

 Defend the computer against viruses, spyware, and other malware  

o Microsoft Security Essentials is a free download for Windows 7 that helps protect 

your computer from viruses, spyware, worms, Trojans, and other malware.  

o Windows 7 also includes Windows Defender, software that helps protect your 

computer from pop-up ads, slow performance, and security threats caused by 

spyware and other unwanted software.  
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EXERCISES 

I. Fill in the blanks with the correct answer by using the words given below 

in the box. 

 

1. Windows _____________________ are Calculator, Paint, Notepad, 

Word Pad etc., 

2. _____________ is a type of malicious program. 

3. ____________________ is an application program designed to detect 

and remove Virus form the computer. 

4. Instead of physical keyboard  _________________ keyboard can be 

used to type the data.  

5. _____________________ allows the user about how to use the 

calculator. 

II. State True or False. 

1. Indian rupee symbol is present on the present day key-boards. 

2. We can use the same key-board to type different languages by 

changing the settings. 

3. Generally functional-keys present on the top row of key-board. 

4. Key-board and Mouse are the basic output devices. 

5. We can remove the virus by Restarting the computer. 

III. Answer the following.  

 1. Name the menus available in the calculator. 

2. Write the three different modes of operations available in the  

magnifier. 

3. What is Minesweeper? 

4. Write the use of Edit menu in the calculator. 

5. Write about Windows Defender. 

Anti Virus, Help menu, On-screen, Virus, Accessories  
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UNIT-VII 

CONTROL PANEL 

7.1 Display Properties 

# Setting Monitor Display Properties 

 Windows allow the user to change the look and feel of the desktop by changing the 

display settings of the monitor.  

 Changing these properties lets the user to set the background of the desktop, screen 

savers, sound schemes and more.  

# Steps to do change the display properties  

 Right-click anywhere on your desktop (except on an icon or shortcut). 

 Select “Personalize” from the menu that appears.  

 A window that allows you to change the display properties of the monitor will appears 

as shown below, 

Figure 7.1: Windows Personalize window 
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# Steps to change the screen saver in Windows 7 

 Click on Start button 

 Click on Control Panel 

 Click on Appearance and Personalization  

 Click on Change Screen Saver in the Personalization group 

 Screen saver settings dialog box  appear as shown below, 

 

 

 

 

 

 

 

 

 

 

Figure 7.2: Screen Saver Settings 

 Click Settings to open a settings window for the selected screen saver (if settings are 

available). 

 Click Preview to see how the screen saver displays on the computer screen. Move the 

mouse when finished previewing the screen saver. 

 Select the number of minutes in the Wait field. This is the number of minutes of 

inactivity before the screen saver opens. 
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 NOTE: 

Make sure the Wait time for the screen saver is lower than the number of minutes 

before the computer enters a sleep state. 

 If you want the computer to require login credentials when the session is resumed, 

select On resume, display logon screen. 

 Click OK to save the settings and close the Display Properties window. 

7.2 Setting of Mouse 

# Mouse pointer 

 The mouse pointer is the graphic image of the cursor displayed on-screen when the 

mouse is active.  

 As the pointer moves over objects, the image changes to reflect the associated 

function.  

 For example, the standard pointing image of an arrow  is Normal 

Select. However, when the computer is processing a command, 

the Busy circle  displays on the screen. 

# Steps to change the mouse pointer (cursor) image 

(Changing the look of your mouse pointer) 

 Click Start .  

 Click on Control Panel . 

 The Mouse Properties dialog box appears as shown below, 
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Figure 7.3 : Mouse Properties Window-Pointers Tab 

 

 Click on Pointers tab. 

 Click the pointer function, in the Customize box or click on Browse button to choose 

a new pointer image. 

(Note: To change the entire scheme of pointers, for example, to change the size of all 

the pointers, click the down arrow in the Scheme field and select a new pointer scheme 

from the list.) 

 Click on Apply button to save your changes. 

 Click on OK button. 

# Changing mouse pointer speed 

Use these steps to change the mouse pointer speed: 

 Click on Start button.  

 Click on Control Panel. 

 The Mouse Properties dialog box appears as shown below 
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 Click the Pointer Options tab. 

 

 

 

 

 

 

 

 

 

 

Figure 7.4 : Mouse Properties Window- Pointer Options tab 

 

1. In the Motion field, click and hold the slide bar while moving the mouse to the right or 

left, to adjust the mouse speed. 

2. Click Apply, and then click OK to save your changes. 
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7.3 Taskbar and Start Menu  

# Taskbar 

 A taskbar shows the currently running programs list. 

 The default settings for the taskbar in Microsoft Windows are at the bottom of the 

screen. 

 This includes the Start button, taskbar icons, notification area, Date and Time from 

left to right as shown below,  

 

 

 

Figure 7.5: Taskbar 

7.4  Date and Time Settings 

# Steps to change Date and Time 

 Click on Start button, Click on Control Panel, Click on Clock, Language and Region 

option and Select Date and Time 

Or 

Click on the clock in the icon tray at the bottom right of the 

computer screen.  

 A Date and Time dialog box appears as shown below, 

 

 

 

 

 

Figure 7.6: Date and Time dialog box 
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 Click on Change date and time button.  

 A Date and Time Settings window appears as shown below, 

 

 

 

 

 

 

Figure 7.7: Date and Time settings dialog box 

 Select the Date, Time. 

 Click on OK button. 
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EXERCISES 

I. Fill in the blanks with the correct answer by using the words given below 

in the box. 

 

 

1. _______________ shows the currently running programs list. 

2. The mouse pointer is the _______________________ of the cursor 

displayed on the screen. 

3. Windows allows the user to change the ____________________ of the 

desktop. 

II. State True or False 

         1. Even though computer is switched off it will maintain current date and 

time. 

          2. To rotate the screen we use Ctrl+Alt+ Arrow buttons. 

          3. By using Date and Time settings in the control panel we can add more 

clocks. 

          4. Auto-hide the task bar option is used to hide the task bar. 

          5. Windows Notification Area is present on the left bottom cornor. 

PRACTICAL EXERCISES   

             1. Change the screen saver of the computer. 

            2. Change the mouse pointer of the computer. 

            3. Set the Date and Time of the computer. 

 

 

Look and Feel, Task bar, graphic image,  
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